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The Kodak i2900 Scanner provides the ability to process scanned
images to improve their quality by using image processing features.

Image processing refers to features of the scanner that allow you to
automatically adjust each image that may improve the resulting images
(i.e., correcting any skew in the fed document, cutting the edges of the
image off to remove unneeded borders or cleaning up extraneous
“noise” on the image).

The ISIS Driver is software that communicates with the scanner. This
driver is created and maintained by EMC Captiva and is provided with
the scanner by Kodak. This driver can be used to interface with many
scanning applications that support ISIS drivers.

The information in this guide provides descriptions of the features on
the tabs of the ISIS Driver windows. The same features should be
available on the user interface of the scanning application you are
using.
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Starting the Scan NOTE: The Scan Validation Tool is provided by Kodak and is a

Validation Tool diagnostic tool only. Kodak does not support the use of the Scan
Validation Tool as a scanning application.

1. Select Start>Programs>Kodak>Document Imaging>Scan
Validation Tool.

' Scan Validation Tool x|

Diiver Types:
Ti/alN -
Dirivers:

2. Select ISIS for the Driver Type and the KODAK i2900 as the driver
and click OK.

3. Click the icon to enable the image view panels.

4. Click the Setup icon on the main Scan Validation Tool screen.

=10 %]

' Scan ¥alidation Tool - ISIS

Dizplay Eveny: |1_
Tatal: Last File: I
| |
The Setup dialog box will be displayed.
setup x|

— Compression

Front Colar:

JPEG
Front Bitonal:

Group-4

Frear Eolor: [none]
JFEG

Frear Bitonal: [none]
Group-4
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5. Click ISIS. The Preset Configurations dialog box will be displayed.
This dialog box maintains a list of saved driver settings.

You can save, delete or import a preset; or select a preset that is
already set up or one you want to modify.

KODAK 2900 on None =l

— Preset Configurations
IR 0

Freset Mame

[Default]
Black andwhite Perfect Page Document
Color Perfect Page Document

Color Photoilaih

Description
Default settings. ;I
r~ Properties
Image... Scanner... |
Ok I Cancel |

6. Click Image to configure settings associated with the image.

The following sections provide descriptions and procedures for
configuring Image settings. See the section later in this chapter

entitled, “Configuring Scanner settings” for scanner configuration
procedures.

A-61776/ISIS October 2012




Configuring Image The main ISIS Driver window provides a set of several tabs for
settings configuring images. You can select each of these tabs and make any
choices necessary to meet your scanning needs.

NOTE: The Image Mode, Camera, Mode and Toggle Patch selections
are available with all of the Image tabs (i.e., Main, Layout,
Image Processing, etc.).

5I
Preset: I:}é‘a,:::é:
~lmage Mode ———————————— h»:éiustmerﬂs | Image Edge Fill | Blank Image Detection | About |
INDrrnaI LI ain | Layout I Image Processing I Auto Color Detect I Dropout
Camega: Dotz per inch:
Front Image #1 500
[ Front Image #2 i
[ Back Image #1 Cropping:
[ Back Image #2 IFiHed To Transport d
Binarization:
iT hreshalding -
Mode: I J
Black and White - [hreshiald
Grayscale 1 =
Color v ID _|:
Auto Detect Grayscale ! !
Auto Detect Color ] 255
i~ Contrast
|
..... Y F =
Toagle Patch: 0 50
off =
Copy | ’TI Cancel | Help Default

Image mode — select one of the following options:

* Normal — typically, for a document, one image is created for the
front side and another image is created for the back side. Select this
option if you want the front and back side to be individual images.

» Merged — select this option if you want one image that contains both
the front side and back side of the document. Image Merge options
are:

- Front on Top; Front on Bottom; Front on Left or Front on Right.

Camera — the selections in the Camera box list the available sides
(front and back) of an image where you can define individual image
processing values. Options include: Front Image #1, Front Image #2,
Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings
independently. Some settings apply only to black and white images,
others apply to color/grayscale images.
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Mode — select one of the following modes:

« Black and White: if you want your electronic image to represent all
elements of your document in black and white.

» Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

» Color: if you want your electronic image to be in color.

» Auto Detect Grayscale: sets auto color detect for grayscale. See
the section entitled, “Auto Color Detect tab” for more information.

» Auto Detect Color: sets auto color detect for color. See the section
entitled, “Auto Color Detect tab” for more information.

Toggle Patch — indicates you want to tell the scanner, via a toggle

patch document, if the document is color/grayscale or black and white.

» Off: no patches will be used.

» Same Side: only the side which recognizes the patch sheet will
toggle.

» Both Sides: a patch will be recognized on either the front or the back
side.
Buttons — the buttons on the bottom of the window apply to all tabs:

» Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up
Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #1.

» OK — saves the values set on all tabs.
» Cancel — closes the window without saving any changes.

» Help — displays on-line help about the options available on the
selected window.

» Default — resets the values on all tabs to the factory defaults.
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Main tab

The Main tab provides the following options:

Preset: |Defaut]i2]

x|

rlmage Mode ————————— Adjustments I Image Edge Fill I Blank Image Detection I
INDrrnaI LI Main | Layout I Image Processing I Auto Color Detect |
Camera: Dotz per inch:

e [ -
[ Front Image #2 i
[ Back Image #1 Cropping:
[0 Back Image #2 IFixed Ta Transport LI
Binarization:
iThreshalding b
Mode: I —I
Black and White - Threshold
Grayscale 1 =
Color ol ID =i
Auto Detect Grayscale ! !
Auto Detect Color ] 255
— Contrast
i =
— P =
Toagale Patch: 50 50
fort =

Copy | ok | Cancel | Hep | Defaut |

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Select a resolution value from the drop-down list. The default is 200 dpi.
Available resolutions are: 100, 150, 200, 240, 250, 300, 400, 600 and
1200 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for dual stream scanning, color/grayscale and black and white
cropping must be the same per side. Only one cropping option can be
assigned per image.

» Automatic: dynamically adjusts the cropping window for different
document sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Fixed to Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed to Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled, “Layout tab” later in this guide.
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* Relative to Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where a separate color/grayscale or black and white area to be
saved is desired. It is useful in applications where a photograph,
signature, embossment or seal appears in a consistent area for an
application (you may want that small area in color/grayscale and the
rest in black and white). To define a zone, select the Layout tab.

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

» iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (i.e., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents. If Fixed Processing is selected, only Brightness
can be adjusted.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (i.e., text, graphics, lines, etc.) from the
background information (i.e., white or non-white paper background).
When using Adaptive Thresholding, Brightness and Contrast can be
adjusted. Use this option when scanning similar type documents.

Threshold (Brightness) — this option is available when you select
Fixed Processing or Adaptive Thresholding (ATP). This option
allows you to change the black and white image to be darker or lighter.
The higher the threshold value, the darker the image. Use the slider to
select a value from 0 to 255. The default is 90

Contrast — adjusts how much of the faint detail you want to see in the
output image. The higher the contrast value, the more faint lines will be
shown in the image. The lower the contrast value, the clearer (or less
detailed) the output image will be. If contrast is set too high, you may
get lines or black areas in your output image that you do not want. If the
contrast is set too low, some letters or lines may not show in the output
image. Select a contrast value from -50 to 50. The default is 50.
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Layout tab

The Layout tab provides the following options:

x|
Preset I:.i:‘:"" 2]
~lmage Mode ———————————————— Adjustments | Image Edge Fill I Blank Image Detection I About |
INorrnaI ;I Main Layout Image Processing | Auto Color Detect I Dropout
Camerm: Page Size:

[ Front Image #2
[ Back Image #1
] Back Image #2

& Portrait

" Landscape
Made: [~ Automatic
Black and White - =
Grayscale
Color

Auto Detect Grayscals
Auto Detect Color

r~ Image Orientation

— Page Orientation
% Top edge first
" Bottom edge first
£ LLeft edae first
= Right edge first

Toaggle Patch:
Off

Kl

Scan fiea... |

cony | ok | cancel |  Hep | Defaut |

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down list.
Page size should be set to the Scanner’s maximum when using the
Automatic or Aggressive cropping option.

Image Orientation

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
to Transport or Relative to Document. See the next section entitled,
“The Scan Area dialog box” for more information.
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Scan Area dialog box The Scan Area dialog box allows you to define the amount of image
data which is returned to the host.

NOTE: Select the Image Mode (either Normal or Merge) based on the
cropping option selected on the Main tab. If you select Normal,
select the side(s) (i.e., Front Image #1, Front Image #2, Back
Image #1 and/or Back Image #2) to be defined.

If you Select Merge, select the orientation of the merged images
(i.e., Front on Top, Front on Bottom, Front on Left or Front
on Right). The scan areas defined for all camera selections are
independent.

» Select Scan Area on the Layout tab to access the Scan Area dialog
box.

NOTE: The Scan Area dialog box is only available when Fixed to
Transport or Relative to Document is selected on the Main
tab.

x

Page Size:
Letter - 85511 in

— Page Layout
' Paotrait
" Landscape

rea

[v Snap

(8

il

v [0
width: |8 1/2"
Height; 11"

Units:

I Inches

()8 I Cancel |

Page Size — the default paper size is set when a scanner is first
selected. You can choose a different paper size using the drop-down
list.

NOTE: Page Size also appears on the Layout tab. If you make a
change on the Scan Area dialog box, the same selection
appears on the Layout tab and vice versa.

Page Layout

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

. __ ]
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Area

* Snap — enable this option to control the dimensions of the preview
area to fixed 0.3175 cm (1/8-inch) increments. This option is not
available in Pixels mode.

» X: the distance from the left end of the scanner to the left-edge of the
scanning area.

* Y: the position from the top end of the document to the top end of the
scanning area.

« Width: the width of the scanning area.
» Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,
Inches or Centimeters.
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Image Processing tab The Image Processing tab provides the following options:

|
Preset: I:::E:EU:::;:
~ Image Mode Ac!justments I Image Edge Fill | Blank Image Detection I About I
|N0rrna| LI Main | Layout Image Processing | Auto Color Detect | Dropout
Camera: — General Options
Front Image #1 O Deskew
L] Front Image #2 [ Halftone Removal
[0 Back Image #1 1 Irwert Image
[ Back Image #2 [m|
[ HoleFill
Mode: Document Type
Black and White ITth with Graphics LI
Grayscale
Color Media Type
Auto Detect Grayscale .
Auto Detect Color IF'Ialn Paper ;I
JPEG Euality
IBetter ;I
Moize Filter
Toagale Patch: ILnne Pixel ;I
off =
— Streak Filter
W on — =
2 2

Copy | oK | Cancel Help Defautt

General Options

» Deskew — automatically straightens a document within 0.3
degrees of the leading edge of the document. Deskew can detect up
to a 45-degree skew and correct up to a 24-degree angle at 200 dpi
or a 10-degree skew angle at 300 dpi. This option is only available
when Automatic is selected.

NOTE: To prevent data loss, the document must have all four
corners within the image path.

» Halftone Removal — enhances images containing dot matrix text
and/or images with shaded or colored backgrounds using halftone
screens and effectively eliminates noise caused by the halftone
screen.

* Invert Image — allows you to select how the black pixels will be
stored in the image. By default the black pixels are stored as black
and the white pixels are stored as white. Turn this option on if you
want the black pixels stored as white and the white pixels stored as
black.

NOTE: You may want to change this option if your application
misinterprets the image data and stores your image in
reverse of what you expect.

» Add Border — allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image. This option is not available
when Aggressive is selected.

1
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Hole Fill — allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g., double-punched or those
having a slight tear that could have occurred when the document was
removed from a binder).

Document Type
» Text: when the documents you want to scan contain mostly text.

» Text with Graphics: when the documents you want to scan contain a
mix of text, business graphics (bar graphs, pie charts, etc.) and line
art.

* Photographs: when the documents you want to scan are comprised
mainly of photos.

Media type — allows you to select the type of paper you are scanning,
based upon the texture/weight. The options are: Plain Paper, Thin
Paper, Glossy Paper, Card Stock, and Magazine.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

» Draft: maximum compression which produces the smallest image
size.

» Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

» Superior: the least amount of compression which produces the
largest image size.

Noise Filter
* None

» Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

» Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vise versa.

Streak Filter — allows you to configure the scanner to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.g., dirt, dust or frayed
edges) or by not following the recommended cleaning procedures for
your scanner. Adjust the extent at which the streaks are filtered by
moving the slider bar from -2 to 2. The default is 0.
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Auto Color Detect tab The Auto Color Detect tab provides the following options. This option is

only available when Auto Detect Grayscale or Auto Detect Color is

selected.
x
Preset: |::=e‘a, t112]

—Image Maode .Rc!justments I Image Edge Fill I Blank ‘an::gec(l,::ete[;:tion | About I
INDI‘ITIEI| LI Main I Layout I Image Processing o Color Detect | Dropout
Camera: Colar Content

Front Image #1
[ Front Image #2
[0 Back Image #1 Color gmount ———— | [~ Color Threshold
[ Back Image #2 —
— I F=| —_ I s0—=1
R A T = =]
1 200 0 100
Mode:
Black and Whits [ Leam
Grayscale Lze the learn mode to determine the proper |
Color I - Colar Amount for detecting your eolar
Auto Detect Grayscale documents. Set the Color Threshald value
Auto Detect Color and click the Leam button to begin.
L]
To?gle Fatoh [ | Amourt Detected: 0
I:"'_ LI Threshold Detected: 0

Copy | oK | Cancel Help Default

Color Content

» Low: documents requiring only a small amount of color to be saved
as color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

» High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.
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» Custom: allows you to manually adjust the Color Amount and/or
Color Threshold.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select Custom option to manually adjust Color
Amount and/or Color Threshold.

Color Amount: the amount of color that needs to be presentin a
document before it will be saved as either color or grayscale. As the
value of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

Color Threshold: the color threshold or intensity (i.e., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required. Valid values are 0 to 100.

Learn — allows you to calculate your settings based on representative
color documents scanned. Before selecting Learn, place at least 5
representative color documents in the input elevator. The documents
will be scanned and analyzed to determine the recommended Color
Amount.

NOTE: The Color Amount and Color Threshold sliders will be
updated automatically. If these values do not provide the
desired results with your job set, you may need to manually
adjust the Color Threshold.
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Dropout tab The Dropout tab provides the following option:

Properties for KODAK i2900 on None x|
Preset: |Defautii2]

o T, ———— ﬁc!justments | Image Edge Fill | Blank Image Detection | I:;“.bm.rtl-rt |
INon—naI LI Main | Layout | Image Processing | Auto Color Detect ropo
Camema: Color Dropout

Front Image #1 Lolor:

[ Front Image #2
[ Back Image #1
[0 Back Image #2

Mode:
Black and White

Grayscale
Color
Auto Detect Color

Taggle Patch:

Copy | oKk | Cancel | Hep |  Defaur |

The Dropout tab is used to eliminate a form's background so that only
the entered data is included in the electronic image (i.e., remove the
form’s lines and boxes). For black and white images, these settings
effect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

Color Dropout
* None

» Multiple: drops colors other than dark shades (e.g. black or dark blue
ink)

* Predominant: drops the predominant color
* Red

* Green

* Blue

Aggressiveness: allows you to adjust the extent at which the colors
are dropped. The values range from -10 to 10. The default is 0.

This option is only available when Color is set to Multiple or
Predominant.
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Adjustments tab The Adjustments tab provides the following options:

=
Preset: I:::E:‘;‘":::Z
Image Mode Main | Layout I Image Processing I Auto Color Detect I Dropout I

-I Mamal LI Adiustments | Image Edge Fill I Blank Image Detection I About
Camea: r~ Color Adjustment

[ Front Image #2 Maral LI

[ Back Image #1 _

[ Back Image #2 Brightress: — J— ||] 3

LContrast: —_— J— IU 3:

Mode: Sharpen: |1 3:

Black and White
Grayscale i~ Color Balance

Auto Detect Grayscale
Auto Detect Color

Toagle Patch:

on o]

~ Background Smoothing

B ackground: IAutomatic-advanced 'l
[ D _:I

-10 10

oy | ok | canced | Hep | Defaut |

Aggressiveness:

Depending on your scanning mode the following options are available:

» Black and White mode: no options are available.
» Grayscale mode: only Background Smoothing is available.
» Color: all options are available.

» Auto Detect Grayscale: Color Adjustment and Background
Smoothing are available.

» Auto Detect Color: all options are available.

Color Adjustments
* (none)
» Automatic: automatically adjusts each image.

» Manual: allows you to set specific values that will be used for all
images:
- Brightness - changes the amount of white in the color or grayscale
image. The values range from -50 to 50.

- Contrast - makes the images sharper or softer. The values range
from -50 to 50.

- Sharpen - increases the contrast of edges within the image. Values
range from O to 3.
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Color Balance
* (none)

» Automatic: adjusts the white background of each document to pure
white. This option compensates for the variations that occur between
different weights and brands of paper.

e Automatic - advanced: for advanced users that want to further
adjust the Automatic option.

- Aggressiveness - allows you to adjust the extent of the variation.
Increasing this value can help with documents that have yellowed
due to age. The values range from -2 to 2.

» Manual: allows you to set specific values that will be used for all
images:
- Red - changes the amount of red in the color image. The values
range from -50 to 50.

- Green - changes the amount of green in the color image. The
values range from -50 to 50.

- Blue - changes the amount of blue in the color image. The values
range from -50 to 50.

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color.

» Background: select one of the following:
- None - no background smoothing will be performed.
- Automatic - smooths up to three background colors.

- Automatic - advanced - for advanced users that want to further
adjust the Automatic option.

« Aggressiveness: allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10.

1
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Image Edge Fill tab This option fills the edges of the final electronic image by covering the
area with the specified color. Image Edge Fill is performed after all other
image processing options have been applied.

zl
Presst: I:::;’;ﬁ-;::;:
~Image Mode ——————————————— Main | Layout | Image Processing | Auto Color Detect | Dropout |
IN Adjustments Image Edge Fil | Blank Image Detection I About
lomal LI

Camera:

r— Image Edge Fil
Fill Calar:

[ Front Image #2
[ Back Image #1

[ Back Image #2

[ Erame Mode

Left: IU.DD in
Mode: . 5
= Right: ID.DD in
Black and White
e Top: [o:00in
Auto Detect Grayscale _ -
Auto Detect Color Bottorn: IU.UU in

Toaggle Patch:

or =]

Copy | oK | Cancel | Hip |  Defaut

Fill Color — allows you to select the color to fill the edges with.
* None
* White
» Black

Frame Mode — fills in an equal amount of the selected color from the
Image Edge Fill drop-down list on all sides of the image, or you can
select a value in the Top, Left, Right and/or Bottom area(s) from each
side of the scanned image to be filled.

NOTE: When using Image Edge Fill, be careful not to enter a value too
large as it could fill in image data that you want to keep.
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Blank Page Detection tab

Blank Image Detection allows you to configure the scanner to not give
blank images to the scanning application. Select the image size (KB),
below which an image is determined to be blank. Images with sizes less
than the number you select will not be created. If you use this option,
you must specify a blank image size for each image type (Black and
White, Grayscale and Color) you want to delete. If you do not make an
entry in these fields, all images are kept.

Properties for KODAK i2900 on None x|
Preset: |Defautii2]
rlmageMode ————— Mﬁih | Layout | Image Processing BI| k:lf\l.rto Cc;r; D;.tect | Dropout |
INon—naI LI Adjustments | Image Edge Fill ank Image ection | About
Camera:  Blank Image Detection
Front Image #1 Mode
Front Image #2 IEontent LI
[ Back Image #1
[0 Back Image #2 [~ Black and White
—_— I = =
i 1 1 ;I
WMode [ Grayscale
Black and White
Grayscale J— I1 % _|:
Auto Detect Grayscale sy
Auto Detect Color R Colo
P =
e | =
1% 100 %
Toggle Patch: i~ Leamn Content
Off -
—I Usze the learn mode to determing Image content Amount.
Lesn | Content: 0%
Copy | oK | Cancel Help Defauit
Mode

» Off: all images are given to the scanning application.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied).

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

Learn Content — allows the scanner to determine the content amount
based on the documents to be scanned. Click Learn to use this
function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.
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About tab The About tab displays information about your scanner and driver.

Properties for KODAK i2900 on None 5[
P [Defautiz]
lmageMode ———————— Main | Layowt | Image Processing | Auto Color Detect | Dgpztut |
i o
INUrrnaI LI Adjustments I Image Edge Fil I Blank Image Detection
Camem

Front Image #1
5 Bock imege 1 FAYA

[ Back Image #2

CERTIFIED

Falcon Yersion 1.1.11210 1004
KODAK i2300 Series Scanner

Mode: Copyright [c) 2012 EMC Corporation
Black and White GuickDriver Yersion 2.0.11204.11001
Grayscals

Device Informatior

At Detect Grayscale
Auto Detect Color

Toagle Patch

or =

EMC. Captiva and 515 are either registered trademarles or
trademarks of EMC Corporation in the United States and/ar
other countries. QuickDriver is a trademark of EMC
Corporation. All other trademarks used herein are the property
of their respective owners

@ Copyright 2012 EML Carporation. Al rights reserved

copy | oK | Cancel Help Default

Configuring Scanner  To access scanner settings from the ISIS Driver, go into the Scan

settings Validation Tool as described earlier in this guide and access the ISIS
driver.

KODAK i2900 on None x|

— Preset Configurations
al | =) o

Freset Mame

[Default]
Black and white Perfect Page D ocument
Color Perfect Page Document

Calar Photoiraih

Description
Default settings. ;I
I-]
r~ Properties
Image... Scanner... |

Ok I Cancel |

» Click Scanner to configure settings associated with the scanner. The
following sections provide descriptions and procedures for
configuring Scanner settings. See the section entitled, “Configuring
Image settings” earlier in this guide for image configuration
procedures.
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Scanner tab The Scanner tab provides the following options:
x|

Preset:

|IDefaut]i2]

Scanner | Mulifeed Detection I Imprinterl Log I About I

i~ Diocument Feeder

Paper Source:
JaDF =l
Feeder Position
¥ Automatically start transport
Sheet Counter ID
r~ Tirneout
¥ On
1 -
L m
1 120 seconds
Besponsze:
IStop Scanning j

Document Protection: I Mormal - l

M aximum Length: |1 4"
Power 5aver: I 158 - l
Power Off: I B0 - l

OK | Cacel | Hdp |  Defaui

Document Feeder

Paper Source

» ADF: the input elevator is in the highest position. This selection is
recommended when you are scanning 25 sheets or less from the
input elevator.

» Flatbed: scanner will scan from the flatbed.

Feeder Position

* Normal: looks for paper in the document feeder first. If there are no
documents in the input tray, the scanner will scan from the flatbed.

Automatic Start Transport — if selected, the scanner will wait for up
to 10 seconds for documents to be placed in the input elevator before
scanning will begin.

Sheet Counter — enter the number to be assigned to the next physical
sheet of paper entering the scanner. This is incremented sequentially
by the scanner and is returned in the image header.
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Timeout — allows you to select the amount of time, in seconds, the
scanner will wait once the last document enters the feeder before the
timeout occurs. This option can also be turned off.

Response — indicates the action that will be taken when the document
feeder timeout has been reached.

» Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job).

» Pause Scanning: scanning will stop but the scanning application will
be waiting for additional images (i.e., stops the feeder). Scanning
may be resumed by pressing the Start/Resume button on the
scanner. Scanning may be stopped by pressing the Stop/Pause
button on the scanner or via the scanning application.

Document Protection — allows you to select how aggressively the
scanner detects documents that enter the scanner incorrectly. This can
occur when documents are not prepared properly for scanning (e.g.
stapled or paper clipped documents).

* None

* Minimum: select this option if the scanner is stopping too frequently
on documents that you do not want it to detect.

NOTE: Documents may become more damaged before detection
occurs.

* Normal: this is the recommended option as it provides a balance
between minimizing document damage and stopping the scanner
unnecessarily.

* Maximum: select this option to get the least amount of document
damage.

NOTE: This may cause the scanner to stop unnecessatrily.

Maximum Length — enter a value that indicates the length of the
longest document in your document set.

NOTES:

» Changing this value will affect the maximums for the following
settings: Area - Width; Height; Printer - Offset From Lead Edge;
Multifeed - Length Detection.

* Not all combinations of settings are supported at the larger lengths
(i.e, resolution, color, grayscale, etc.). To allow for greater flexibility
with applications, the scanner will not generate an error until it sees a
document whose length is not supported.

» The scanner’s throughput may be reduced for larger lengths.

Power Saver — allows you to set the amount of time (0 to 240
minutes) the scanner will remain inactive before the scanner goes into
an idle state. The default is 15 minutes.

Power Off — allows you to set the amount of time (0 to 240 minutes)
the scanner will remain inactive before the scanner will turn the power
off.
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Multifeed Detection tab Multifeed detection aids in document processing by detecting
documents that may go through the feeder overlapped. Multifeed can
happen due to stapled documents, adhesives on documents or
electrostatically charged documents. The Multifeed Detection tab
provides the following options:

Properties for KODAK i2900 on None 5'

Preset: I::E—'E_-_::;:

Scanner Multifeed Detection |Imprinter| Log I About I

r~ Multi-Feed Detection
¥ Length Detection

I ax Length:

™| Auta Sef
¥ Ultrazonic Detection

Sengitivity: I tedium - l

Action:

Stop Scanning - generate imagez)

— O perations

LCalibrate... |

ok | Cacel |  Hep | Defatt |

Length Detection — when you enable Length Detection you can
select the maximum length of the document that can be scanned
without a multifeed being detected. Length detection is used when
scanning same-sized documents to check for overlap. For example, if
you are scanning A4 (8.5 x 11-inch) documents in portrait mode, enter a
value of 28.57 cm (11.25 inches) in the Max Length field. The maximum
value is 35.56 cm (13.99 inches).

» Auto Set: automatically sets the maximum length value to 1.27 cm
(.50-inch) greater than the length of the currently selected page size.

Ultrasonic Detection — check this option to set multifeed detection.

» Sensitivity — controls how aggressively the scanner will work to
determine if more than one document is fed into the transport.
Multifeeds are triggered by detecting air gaps between documents.
This allows multifeed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: the least aggressive setting and is less likely to detect
labels, poor quality, thick or wrinkled documents as multifed
documents.

. __ ]
A-61776/ISIS October 2012 23




- Medium: use Medium sensitivity if your application has varying
document thickness or labels attached to the document.
Depending on the label material, most documents with labels
should not be detected as a multifed document.

- High: the most aggressive setting. This is a good setting to use if
all documents are similar in thickness to 75.2 g/m2 (20-Ib.) Bond
paper.

» Action — select what action you want the scanner to take when a
multifeed is detected. With all options, the condition will be logged in
the scanner.

- Continue Scanning: the scanner will continue to scan.

- Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job). Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

- Stop Scanning - generate image(s): scanning will stop and
control will return to the scanning application (i.e. ends the job).
Image(s) of the multifed document will be generated. Verify that
the paper path has been cleared and restart the scan session
from the scanning application.

- Pause Scanning: scanning will stop but the scanning application
will be waiting for additional images (i.e., stops the feeder).
Scanning may be resumed by pressing the Start/Resume button
on the scanner. Scanning may be stopped by pressing the Stop/
Pause button on the scanner or via the scanning application.

- Pause Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) but
the scanning application will be waiting for additional images (i.e.,
stops the feeder). Clear any documents from the paper path prior
to resuming the scan session. Scanning may be resumed by
pressing the Start/Resume button on the scanner. Scanning may
be stopped by pressing the Stop/Pause button on the scanner or
via the scanning application.

- Stop Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) and
control will return to the scanning application (i.e., ends the job).
Clear any documents from the paper path prior to restarting the
scan session from the scanning application.

Speaker icon — clicking this icon will display the Open dialog box
allowing you to select the desired tone (.wav file) for your alarm.

Calibrate — displays the Calibration window allowing you to perform a
UDDS calibration.

NOTE: Frequent calibration is not necessary or recommended. Only
perform a calibration when instructed to do so by your support
personnel.
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Imprinter tab

The printer operates at full scanner speed. The printer can add a date,
time, document sequential counter, and custom messages.

The print string can be configured to include both literal (static)
information (i.e., information that stays the same for each document,
such as batch name or operator) and dynamic information (i.e.,
information that may change for each page scanned, such as the
document sequential counter). The capture software application
controls static fields; any information that the software allows you to
enter can be sent to the printer.

x
Presat: I:::E:E” t][2]
Scannerl Multfeed Detection  Imprirter I Log I About I

r— Digital Stamp

tode: Alignment;

IFront Side j

Format Template: Top Margin:

| @ |0in

—Date Units:
Format: Delimiter: I Inches - l
MDD x| [Nane =] | Fon

INormaI 'l

r— Counter Botation ————
Field itk I = [0Degiees 7]
Format:
IDispIa_l,l Leading Zeroz j H

Example:

ok | Cacd |  Hp | Dt |

Digital Stamp: Mode — to enable this option, select Front Side.

Alignment — select where you want the print string to be placed.
Options are: Left, Center, Right.

Format Template — the format template is used to build the print
string. The print string is what is printed on documents as they travel
through the transport. The print string is printed before the document is
scanned, therefore, it is part of the image. The maximum amount of
characters for each print string is 40 characters (including spaces).

Date — if you want to add a date to the print string, select one of the
following formats:

* Format: MMDDYYYY, DDMMYYYY, YYYYMMDD, YYYYDDD or
DDD.

» Delimiter: select one of the following separators: slash: /,
dash: -, dot: ., space or none. For example: 08/24/2010,
08-24-2010, 08.24.2010 or 08 24 2010 or 08242010 (none).
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Counter — if you want to add a Counter to the print string, you can
enter one of the following options:

e Field Width: used to control the width of the document counter.
Values range from 1 to 9.

* Format — allows you to configure the format of the counter when the
width of the value is less than the field width (the examples indicate a
field width of 3 and the counter at 4). Options are:

- Display Leading Zeros (default): “004”
- Suppress Leading Zeros: “4”
- Compress Leading Zeros: * 4

Top Margin — allows you to define the distance from the lead edge
before the print string begins. Enter the desired amount in the text box.

NOTE: Printing automatically stops 6.3 mm (1/4-inch) from the trailing
edge of the document even if the information has not been
completely printed.

Units — select Inches, Centimeters or Pixels.

* Font — you can select what orientation you want your information to
be printed.

- Style: available character styles: Normal, Large and Bold.

e Lt )
e A% aE
M ™ ™

Normal: 90° rotation Large: 90° rotation Bold: 90° rotation

Rotation — you can select either 0 or 90 degrees.
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Logs tab The Logs tab provides a listing of any errors that have been
encountered.

Properties for KODAK i2900 on None x|

Preset: I:[:efault: 2]

Scannerl Multifeed Detedionl Imprirter  Log |Abc|.rt |

KODAE 12900 on Hone

ok | camcel |  Hep | Defautt |

You can view the Operator and Meter logs and save this information to
a file by clicking the Save icon, or copy the information to the clipboard
which can then be pasted into a document.
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